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Introduction: 
Spreadsheet programs allow users to develop a number of documents that can be used to store data, perform 
calculations, and display values or figures graphically. A spreadsheet may be used to calculate the earnings of business 
products for the year, or it simply may be used to keep track of  
monthly bills, sports pools, etc. This class is targeted at beginners and is intended to provide the basics for using a 
spreadsheet program. 
 
Objectives: 
 � Learn basic navigation skills to effectively use the Microsoft Excel program. 
 � Create and edit a simple spreadsheet. 

 � Format the spreadsheet and perform calculations. 
 � Preview, print, save, and open files. 
1) Understanding Spreadsheet Basics 
 � What Is a Spreadsheet Program? 
 � Access Microsoft Excel 
 � Explore the Excel Window 
2) Creating A Simple Spreadsheet 
 � Enter Data and Edit Cell Contents 
 � Navigate and Select Cells 
 � Move and Copy Cells 
 � Save File to Disk 
3) Calculating and Formatting 
 � Use AutoSum 
 � Format Values 
 � Format Cells 
4) Page Layout and Printing 
 � Access Print Preview 
 � Adjust the Page Layout 
 � Print the File 
 � Open File 
 
The Microsoft Excel program allows you to create files that can help organize and analyze data as well present 
information graphically in chart or graph format. The following outline provides key definitions and descriptions of many 
terms and concepts. 
 
1) The Microsoft Excel Program 

a) Uses for Excel 
i) Spreadsheets 
ii) Databases 
iii) Charts and Graphs 

b) The Excel File 
i) The workbook is the basic Excel file. By default it contains 3 worksheets. However, you may insert up to 255 

worksheets in one workbook. 
 
2) The worksheet is made up of 256 columns, labeled alphabetically along the top and 65,536 rows, labeled 

numerically along the left hand-side of the screen. 
 
3) The basic building blocks of an Excel worksheet are cells. There are over 16.7 million cells in one worksheet. 

a) Data 
i) Labels (text) 
ii) Values (numbers) 
iii) Formulas or functions (calculations, operations) 

b) Other Terms 
 
4) Each cell has an address made up of the column letter followed by the row number. For example, A1, B3, C5, D10, 

G25, and so forth. 
i) Home is used to refer to the first cell within the worksheet, or cell A1. 
ii) A group of cells is commonly referred to as a cell range. 

 
5) The active cell in a worksheet can be identified by the cell selector, or the bold, darkened line that which appears 

around the cell. The address of the cell will display on the formula toolbar of the active cell. 
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Spreadsheet, Database, and Chart 
 
Spreadsheet:  spreadsheet organizes information into columns and rows. A spreadsheet may be used to calculate the 
earnings of business or it simply may be used to keep track of monthly bills. 
 

  
 
Database: 
A database is used to create and manage large amounts of information in one place. Fields are established 
representing single pieces of information (for example, first name, last name, address). A complete set of fields 
represents one record. You can create a database to organize contact information for family, friends, and business 
associates or to organize a collection of recipes, books, or CDs. 
 

 
 
Chart: 
A chart provides a graphic display of values. Often times, a chart is a user-friendly visual depiction of trends for a financial 
quarter, profits for a business, or the allocation of personal expenses. 
 

 

  

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec

2010 2,77 5,23 5,32 3,63 3,17 2,96 3,63 2,11 5,15 2,69 3,80 4,07

2011 4,68 4,01 4,57 5,05 0 0 0 0 0 0 0 0
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Accessing Microsoft Excel 

 
1) Click the Start button on the taskbar at the bottom left-hand corner of the screen - The Start menu opens. 

2) Click on All Programs - A submenu opens.  

3) Click on Microsoft Office 2010 -  A submenu opens. 

4) Click on Microsoft Excel 2010 - The Microsoft Excel program launches. 
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Microsoft Excel Window 
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Standard Toolbar 

 

 

 

 

 

 

 

 

 

 

Microsoft Excel Formatting Toolbar 
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Microsoft Excel Menus 
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Use the mouse by pointing 
and clicking on the desired 
cell.  The cell selector will 

appear around the cell and 
the address appears in the 

formula bar.

 

Navigating and Selecting Cells 

Navigate: 

In order to use the Excel program effectively is important to know how to move around 

the worksheet and workbook.  You can use both the mouse and the keyboard to 

navigate. 

 

Keyboard Action Moves… 

Enter next row 

Tab next cell 

Shift + Enter previous row 

Shift + Tab previous cell Shortcut Keys Moves… 

 one cell left Ctrl +  last column 

 one cell right Ctrl +  last row 

 one row up Ctrl +  first column 

 one row down Ctrl +  first row 

Home beginning of row Ctrl + Home beginning of worksheet 

Page up up a screen length Ctrl + Page Down next worksheet 

Page Down down a screen length Ctrl + Page Up previous worksheet 

 

Select: 

If you want to make any changes to a cell or the text in it you need to select it, or a range of cells.  You can do this in a 

number of ways using the mouse or the keyboard. 

Mouse Selects… Keyboard Selects… 

Click, hold, and drag specified area Ctrl +A entire worksheet 

Click Column Headers entire column Shift +  one cell to the left 

Click Row Headers entire row Shift +  one cell to the right 

  Shift +  one row up 

  Shift +  one row down 

  Shift + Home current cell to beginning of row 

  Ctrl + Shift + Home current cell to beginning of worksheet 

  

Shift Clicking – to select a group of cells. 
1. Point and click the mouse where 

you would like the selection to 
begin. 

2. Hold the Shift key. 
3. Point and click the mouse where 

you would like the selection to end. 

Control Clicking – selects specific cells in the 
workbook. 

1. Point and click the mouse on a cell. 
2. Hold the Ctrl key. 
3. Point and click on other cell(s). 
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Microsoft Excel Cursors 

Selecting Cells 

The cursor changes into a white cross when cells are selected.  

Notice that one cell remains clear, while all other selected cells are 

shaded.  

 

 

Resizing Columns and Rows 

When you move the cursor between the column or row headers, it changes into a 

double-sided arrow.  Just click, hold and drag to resize the column or row, or 

double click, and Excel will AutoFit (the width or height increases or decreases 

depending on the amount of data within the cells).  If you select multiple rows or 

columns they will all be adjusted the same way.  

 

Copying Cells 

To copy the content of one cell, move your cursor to the lower right hand corner 

of the cell.  When the cursor changes into a bold, dark cross, click, hold and 

drag to copy the contents to the specified cell(s).   
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Creating a Spreadsheet 

The following exercise will provide instruction on creating a sample spreadsheet.  Spreadsheets provide a fast and 

efficient method of organizing information and specifically performing calculations.  The spreadsheet we will be creating in 

class focuses on tracking monthly expenses.  You may want to create your own spreadsheet once you have completed 

the class. 

1. Click in cell A1 and type “Monthly Expenses.” 

2. Press the Enter key.  

3. In cell A2 type “First Quarter” and press the Enter key. 

 You will notice that the text is overflowing into the next column. 

4. To resize column A move your cursor in-between columns A and B.  When 

the resizing cursor displays, double-

click to automatically adjust the column 

width or click and drag to mannually 

adjust the column width. 

5. Click in cell B3 and type “Expenses” 

and press the Enter key.  

6. Type the following monthly expenses 

and press the Enter key after each 

one:  Rent, WE Energies, Phone, Groceries, and Total. 

7. Click in cell C3 and type “January” and press the Tab key.  

8. Move your cursor to the bottom right hand corner of C3. 

 The Copy Cursor should display. 

9. Click and drag the cursor to fill in the months February, March, and April in cells D3 to F3. 

10. Click in cell G3 

and type “Total”. 

11. Type in the 

values listed in 

the graphic to 

the right. 

 

  

 
Fixing Mistakes 

 To correct mistakes as you type, press the Backspace key. 

 To clear the contents of a cell(s), click on the cell or select the cell 
range and press the Delete key. 
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Saving a File to Disk 

Once you have created a spreadsheet, you may wish to save it onto a disk for later use.  After it has been 

saved onto a disk, you will always have a copy of the document if you wish to print another copy or revise 

it for future use. 

1. Click the File and then Save.   

2. The Save As dialog box opens. 

3. In the “File Name” box, type a name for your file (e.g. 

“Class Exercise”) 

4. Select the location that you want to save the file to in the 

box at the left of the screen.  In this case we’ll save it to the 

“public (//server (P:) drive. 

 

 

 

 

 

 

 

Tips: 

- As you continue to work on your spreadsheet, click the Save button periodically to save your work.  Some 

recommend saving every 5 to 10 minutes. 

- The Save As dialog box only opens the first time you save.  After that, your spreadsheet will be saved in the 

same location with the same file name. 

- If you would like to save the file in a new location, or with a different name, click on the File menu and select 

Save As. 
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Auto Sum 

The Microsoft Excel program allows users to insert formulas and functions in the spreadsheet ranging from simple 

addition and subtraction operations to calculating percents and averages.  You do not have to be a math whiz or computer 

expert to perform such calculations.  The AutoSum command allows users to quickly add up a column or row of values by 

a simple click of the mouse. 

1. Click in cell C8, 

2. Click the AutoSum button once on the standard toolbar. 

 Dotted lines, sometimes called 

“marching ants”, surround cells 

C4 thru C7 and a function: 

=SUM(C4:C7) is placed in cell 

C8.  

3. Click the AutoSum button again, or 

press the Enter key 

 The sum total “993” appears in 

cell C8.  Notice that the 

formula displays the function.  

4. To copy the function, move your cursor 

to the bottom right hand corner of cell 

C8 to display the copy handle.  

5. Click, hold and drag your mouse to 

copy the function into cells D8 thru F8. 

6. Totals display in cells D8 and F8.  

 If one of the values in the cell 

range C4 through F7 is 

changed, the total will 

recalculate automatically. 

7. Click in cell C7 and type 200 and press 

the Enter key. 

 Notice the total in cell C8 

changes to 1,020.  

8. Now try following the same steps to 

total cells G4 thru G8 

 

For more advanced functions available, click the Insert Function button on the Formula toolbar. 
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Formatting Values 

Once you have created a spreadsheet, you may wish to format the values to create a professional looking document. 

You may wish to display dollar signs or percentages depending on the content of the cell(s). 

Formatting Values: 

1. Select cells C4 through F8.  

2. Click the Currency Style button 

3. Click the Percent Style button. 

4. Click the Comma Style button. 

5. Click the Increase Decimal button. 

6. Click the Decrease Decimal button. 

7. Decide what formatting option you would like to use and apply it. 

 

To get rid of the comma or change other settings: 

1. Click on the bottom right corner of the number 

formatting area on the Home toolbar 

2. In the Format Cells menu select Number. 

3. Untick the Use 1000 Separator (,) 

 

 

 

 

 

Other tips: 

 If the value in the cells display as pound signs (######) it means there is not 

enough room to display all the content of the cell.  You need to make the 

column wider by double clicking between the column headers.  You can also 

click on Format in the Cells menu under the Home tab and set AutoFit 

Column Width.  

  

Currency 
Style 

Percent 
Style 

Comma 
Style 

Decrease 
Decimal 

Increase 
Decimal 
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Formatting Cells 

Once you have created a spreadsheet and formatted the values, you can make changes to the appearance of the cells.  

You can change the font, or font size, adjust the style by making certain cells bold or italicized, or adjust the alignment or 

orientation of the cells.  The following exercise highlights some 

of the formatting options available. 

1. Select cells B3 through B8. 

2. Click the Bold button on the formatting toolbar under 

the Home tab. 

3. Select cells C3 through G3. 

4. Click the Down Arrow of the font menu and select 

another font.  

5. Click on the Bold button. 

6. Click on the arrow in the bottom right hand corner of the 

Font menu to open the Format Cells menu. 

7. Click, hold, and drag the red dot on the end of the text 

orientation “clock” to change the angle of the words in 

the highlighted cells. 

8. Click OK 

9. Select cells A1 through G2. 

10. Click the Merge and Centre button in the Alignment 

menu under the Home Tab 
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Adjusting the Page Layout 

After you have edited and formatted a spreadsheet you can make other adjustments such as changing the margins, 

modifying the orientation, or centering the spreadsheet on the page.  These actions can be performed in the page 

setup dialog box.  

1. Click on the Page Layout tab. 

2. Click the arrow under Margins and select Wide for 

margins that are one-inch top, bottom, left and right. 

3. Click on the arrow under Orientation and select 

Landscape. 

4. Click on the bottom right hand corner of the Page 

Layout menu to open the Page Setup dialogue box.  

5. Click on the Margins tab in the Page Setup dialogue 

box. 

6. To print gridlines click the Sheet tab and check 

the Gridlines checkbox. 

7. To centre your table on the page check the boxes next to 

Horizontally and Vertically  

8. Click the OK button on the bottom right hand corner of 

the dialogue box. 

9. Select Print under the File menue to see a preview of 

what your printed page will look like. 
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Printing the Worksheet 

 To print a copy of your worksheet click on the 

File tab then select Print. 

 You can choose the number of prints you 

want to make. 

 Print just the “Active” sheet you are working 

on, an entire workbook (if you have more 

than one page), or just some specifically 

selected cells. 

 You can also make choices for multiple 

pages (printing double sided, or collating) 

 You still have options to change page 

orientation, paper size, and margins. 

 Once you are finished making your choices 

click on the Print button at the top of the 

frame. 

Note:  If you are printing pages at the Kenora Public Library there is a $ .25/page charge for black and white copies, or 

$1/page for colour copies.  Be sure to check how many pages are in your workbook/worksheet before you print. 

 

Opening a File 

Once you have saved your file to a disk or jump drive 

you can open it to work on it again. 

1. Put your storage device in the appropriate 

drive or slot (CD or jump drive). 

2. Open Excel (start > all programs > Microsoft 

Office > Microsoft Excel 2010). 

3. Click on File, then Open. 

4. Select the appropriate drive from the selection 

in the left hand window. 

5. Select the folder/or file from the right hand 

window. 

6. Double click on the file, or click on Open. 
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Prepared for the Kenora Public Library 2011. (special thanks to the Milwaukee Public Library Foundation) 


